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Overview 
The following processing guidelines apply to budget accounts: 

Updating and Displaying Budget Accounts:  Inquire on budget accounts by specific account, by partial 

number scan, and by partial number summary.   

Inquiries:  Inquiring by a partial budget account number allows record viewing for all records containing the 

numbers entered.  For example, when entering ‘1000’ in the Fnct (Function) field, all records containing a 

function code of ‘1000’ display sequentially. 

Additions/Updates:  Create budget accounts to enter the fiscal year’s budget for a specific account.  

PCGenesis may automatically distribute the original budget estimate to monthly amounts, or the monthly 

distribution amounts may be entered manually.  All account number “pieces” must exist in the Account 

Master Description File before creating the account record by using these procedures.  Refer to Section K:  

Account Master Description File Processing for instructions. 

All budget account additions, modifications, and deletions generate entries in the AUDIT file and on the 

General Ledger (G/L).  The G/L entry debits or credits the appropriate accounts.  PCGenesis does not allow 

the deletion of budget accounts unless the Adjusted Budget Amount and the Original Budget Amount are zero.  

Also, PCGenesis does not allow the deletion of budget accounts when there are purchase order encumbrances 

and/or claims and expenditures recorded against the account. 

PCGenesis does not allow budget account modifications for the Payroll Withholding Fund 199 and for Closed 

budget accounts.  (PCGenesis automatically updates the Payroll Withholding Fund’s information when 

posting the payroll.)  PCGenesis allows the viewing of these accounts however. 

Printing the Budget Chart of Accounts:  The Budget Chart of Accounts provides a listing of active 

budget accounts for a specific date range.  PCGenesis displays these accounts with the original and/or 

current budget, and/or the current balances.  Closed budget accounts may also be included in this listing 

of accounts.  This procedure will also create a budget account Export file for processing via Microsoft® 

Excel, where applicable.  

The printing the Budget Chart of Accounts procedure will also create a budget account Export file which 

can be used by the Budget Load from External File procedure to create a new fiscal year’s chart of 

accounts and budget entries.  This can be done by printing the Budget Chart of Accounts and selecting 

the radio button corresponding to Export for New Fiscal Year BUDGET LOAD in the Create 

EXPORT File to load in Excel field.  Selecting the budget account Export file for a new fiscal year 

creates the new fiscal year’s budget, based on the current year’s budget account information.   

PCGenesis performs the following during this process: 

 The radio button option Export for New Fiscal Year BUDGET LOAD in the Print the Chart of 

Accounts function, allows the user to specify the types of budget accounts to export.  By selecting 

the appropriate radio button the user can export all budget accounts, salary and benefit budget 

accounts only, or all budget accounts except for salary and benefit budget accounts.  

 After the Export for New Fiscal Year BUDGET LOAD option is selected, the user specifies the 

New Fiscal Year and the % Budget Change values.  For example, users may apply a formula to 

each budget account to increase the budget amount by 3%.  If the new fiscal year’s budget remains 

unchanged from the prior fiscal year, the % Budget Change value can be set to zero. 
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 The Export for New Fiscal Year BUDGET LOAD process exports the current fiscal year’s budget 

accounts and amounts from PCGenesis, applies the % Budget Change factor, and calculates a New 

Budget amount for each account.  The export process creates a Comma Separated Value (.csv) file.  

The .csv file can be loaded into Microsoft® Excel for further editing if additional modifications are 

needed for the budget account numbers or budget amounts. 

 After saving the Microsoft® Excel spreadsheet as a comma delimited (.csv) file, and after using the 

PCGenesis Import procedure to upload the information, the user must verify the budget figures for 

accuracy. 

Performing the Budget Account Upload:  Performing the budget account upload creates the new fiscal 

year’s chart of accounts and budget values based on the contents of a Comma Separated Value (.csv) 

import file.  The import file must contain the following information for each general ledger account:  the 

budget general ledger account number, the balance sheet account code, the account description or title, 

and the budget amount. 

   

Summary of Budget Account Add/Update Options 

Add Budget Account 

 Refer to Topic 2:  Adding a Budget Account in this document 

 When an account does not exist, use F1 to add 

 Enter Orig. Budget (Enter original budget) field 

 Optional:  Allocate the Original Budget Amount over the 12 months, or allow the system to 

automatically allocate the Original Budget Amount over the 12 months 

 Fill in other fields as necessary 

 ENTER twice to post 

 Outcome:  The Adj. Budget (Adjusted Budget) field is replaced by the amount entered in the 

Enter Orig. Budget field 

 Outcome:  The Orig. Budget (Original Budget) field is replaced by the amount entered in the 

Enter Orig. Budget field 

 Outcome:  The Enter Orig. Budget amount is automatically allocated over the 12 months 
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Update Budget Account - Update Adjusted Budget 

 Refer to Topic 3:  Updating a Budget Account in this document 

 The account must exist 

 Optional:  Enter Budget Adjustment field 

 Required if Budget Adjustment field entered:  Allocate the Budget Adjustment amount over 

the 12 months 

 Update other fields as necessary 

 ENTER twice to post 

 Outcome:  The Adj. Budget (Adjusted Budget) field is increased (positive adjustment) or 

decreased (negative adjustment) by the amount entered in the Enter Budget Adjustment field 

 Outcome:  The Orig. Budget (Original Budget) field remains unchanged 

 Outcome:  The Distribution by Month fields are increased (positive adjustment) or decreased 

(negative adjustment) by the amounts shown on the screen 

 

Update Budget Account - Update Adjusted Budget and Original Budget 

 Refer to Topic 3:  Updating a Budget Account in this document 

 The account must exist 

 Optional:  Enter Budget Adjustment field 

 Optional:  Allocate the Budget Adjustment amount over the 12 months, or allow the system to 

automatically allocate the Budget Adjustment amount over the 12 months 

 Update other fields as necessary 

 Select F31 to Adjust Original Balance, and then ENTER to post 

 Outcome:  The Adj. Budget (Adjusted Budget) field is increased (positive adjustment) or 

decreased (negative adjustment) by the amount entered in the Enter Budget Adjustment field 

 Outcome:  The Orig. Budget (Original Budget) field is increased (positive adjustment) or 

decreased (negative adjustment) by the amount entered in the Enter Budget Adjustment field 

 Outcome:  The Distribution by Month fields are increased (positive adjustment) or decreased 

(negative adjustment) by the amounts shown on the screen 

 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  1:53 PM  Page 4 of 65 

All Rights Reserved. 

Upload Chart of Accounts and select ORIGINAL upload option 

 Refer to Topic 6:  Importing the Microsoft® Excel Budget.csv File into PCGenesis, 6B. Budget 

Load from External File in this document 

 The account may or may not exist.  If the account does not exist, it will be automatically created 

by the system. 

 Required:  Column K - Budget Amount must be entered in the .csv upload file 

 Enter all other required fields in the .csv upload file 

 Select the ORIGINAL upload option 

 Outcome:  The Adj. Budget (Adjusted Budget) field is replaced by the amount entered in 

Column K - Budget Amount 

 Outcome:  The Orig. Budget (Original Budget) field is replaced by the amount entered in 

Column K - Budget Amount 

 Outcome:  The Column K - Budget Amount is automatically allocated over the 12 months and 

replaces the prior monthly allocations 

 

Upload Chart of Accounts and select ADJUST upload option 

 Refer to Topic 6:  Importing the Microsoft® Excel Budget.csv File into PCGenesis, 6B. Budget 

Load from External File in this document 

 The account must exist 

 Required:  Column K - Budget Amount must be entered in the .csv upload file 

 Enter all other required fields in the .csv upload file 

 Select the ADJUST upload option 

 Outcome:  The Adj. Budget (Adjusted Budget) field is replaced by the amount entered in 

Column K - Budget Amount field 

 Outcome:  The Orig. Budget (Original Budget) remains unchanged 

 Outcome:  The Column K - Budget Amount is automatically allocated over the 12 months and 

replaces the prior monthly allocations 

 

Printing the Detail of Expenditures Report:  The Detail of Expenditures Report provides a listing of 

individual budget account expense activity (expenditures). 

Performing the Fiscal Year Budget Account Rollover:  When PCGenesis users “roll” budget account 

activity to the new fiscal year PCGenesis transfers active budget account activity to the upcoming fiscal 

year.  In doing so, the procedure ignores budget accounts without activity, budgeted amounts, and/or 

Balance Sheet account numbers during the procedure for the new fiscal year. 

Drop-Down Selection Icon Feature: Certain fields within PCGenesis contain the drop-down selection icon 

 to aid in the entry of field information.  When used, double-select the desired information to complete the 

entry.   
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Screen Print:  The screen print feature allows the user to obtain a screen print of the Budget Account 

Inquiry screen.  The screen print feature is available on display/inquiry screens which have the  

button.  The screen print file will be available in the print queue with the name ‘PSCNnnnn’. 
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Topic 1:  Inquiring on a Budget Account 
Step Action 

1  From the Business Applications Master Menu, select  (F1 - Financial Accounting & 

Reporting System). 

 

The following screen displays: 

 

Step Action 

2  Select  (F1 - Budget Account Master Menu). 
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The following screen displays: 

 

Step Action 

3  Select  (F1 - Account Inquiry). 
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The following screen displays: 

 

Step Action 

4  Enter the complete or partial account information in the Yr Fnd F Prgm Fnct Objct Fcty B 

Addt'l field and select the appropriate option: 

Option 1 to recall a specific account:  Enter or select the drop-down selection icon  in 

the Yr Fnd F Prgm Fnct Objct Fcty B Addt'l field to choose the account, and select  

(Enter). 

Option 2 to scan all matching line items:  Enter the partial account information in the Yr 

Fnd F Prgm Fnct Objct Fcty B Addt'l field, and select  (F2 – scan).  (If no entry is 

made, PCGenesis defaults the account parts to zeroes.) 

Option 3 to summarize all matching line items:  Enter the partial account information in 

the Yr Fnd F Prgm Fnct Objct Fcty B Addt'l field, and select  (F3 – summarize). 

If the budget account does not exist, “*** RECORD NOT FOUND***” displays to the right 

of the entry.  In this instance, reenter the account number correctly, and select  

(Enter), or select  (F16 – Exit) to return to the Budget Account Master Menu. 
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The following screen displays if the account exists: 

 

 

 

Claims equal net of open claims and prior year cancelled claims. 

Step Action 

5  Review the information displayed on the Budget Inquiry screen. 

Select  (F17 – Print Screen) to obtain a screen print of the Budget Account Inquiry 

screen.  The screen print file will be available in the print queue with the name 

‘PSCNnnnn’. 

To view additional budget accounts, select Enter,  (F1 - Next) or  (F2 - Prev) 

until “*** END OF FILE***” displays. 

6  Select  (F16 – Exit) to exit the Budget Account Inquiry screen. 

 

  

Based on Step 4 entries, PCGenesis will allow the next record of this type to be viewed, 
or the preceding record to be redisplayed with the selection of F1 (Next) or F2 (Prev). 
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The following screen displays: 

 

Step Action 

7  Select  (F16 – Exit) to exit to the Budget Account Master Menu. 
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The following screen displays: 

 

Step Action 

8  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu or 

select  (Master) to return to the Business Applications Master Menu. 
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Topic 2:  Adding a Budget Account 

 

Step Action 

1  Select  (F1 - Budget Account Master Menu). 

 

The following screen displays: 

 

Step Action 

2  Select  (F2 - Account Add/Update). 
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The following screen displays: 

 

Step Action 

3  Select the drop-down selection icon  or enter the account number information in the Yr 

Fnd F Prgm Fnct Objct Fcty B Addt'l field and select  (Enter). 
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The following screen displays: 

 

Step Action 

4  Verify “*** Record Not Found ***” displays, and select  (F1 to Add). 
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The following screen displays: 

 

Step Action 

5  Enter the effective date (MM/DD/CCYY) of the budget’s appropriation in the Tran date 

(Transaction date) field. 

The Tran Date (Transaction Date) determines when the transaction occurs.  Although 

PCGenesis defaults to the current date, it is recommended that the transaction date be 

changed so that the transaction date and the begin date are identical.  Some reports, 

including the DE0046 and DE0396, will not include the account information if the report is 

created with a date that is prior to the transaction date, even though the begin date falls 

within the report range. 

6  Enter the date range (MM/DD/CCYY) in the Beg Date (Beginning Date) and End Date 

(Ending Date) fields. 

The account will be active for the date range entered. 

7  Enter 0799 (General Fund) or 0740 (School Food Services) in the Fund Balance Acct (Fund 

Balance Account) field. 

8  Enter the dollar amount in the Enter Orig. Budget (Enter Original Budget) field. 

9  Enter the reason for the creation of the account in the Reason field where appropriate. 
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Step Action 

10  Enter the account name, up to thirty (30) characters, in the Title field where appropriate. 

If the Title field is blank, PCGenesis will automatically default to the title of the previous year’s 

account name if it exists. 

11  To manually enter the monthly amounts:  Enter the account’s monthly total in the Enter 

Distribution by Month field and select  (Enter - to Process) once. 

To allow PCGenesis to automatically distribute the monthly amounts:  Select  (Enter) 

once.  PCGenesis redisplays the Budget Add screen with amounts equally distributed over the 

months. 

Select  (F17 – Print Screen) to obtain a screen print of the Budget Add screen.  The 

screen print file will be available in the print queue with the name ‘PSCNnnnn’.   

 

The following screen displays: 

 

Step Action 

12  Verify the amounts are correct and select  (Enter - to Post). 

If the information is incorrect, select  (F16) to enter the correct information and 

select  (Enter) twice. 

13  Record or screen-print the account’s information where appropriate. 

PCGenesis account 

distribution 
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The following screen displays: 

 

Step Action 

14  Select  (F16 - Exit) to return to the Budget Account Master Menu. 

 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  1:53 PM  Page 18 of 65 

All Rights Reserved. 

The following screen displays: 

 

Step Action 

15  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu or 

select  (Master) to return to the Business Applications Master Menu. 

 

 

 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  1:53 PM  Page 19 of 65 

All Rights Reserved. 

Topic 3:  Updating a Budget Account 

 

Step Action 

1  Select  (F1 - Budget Account Master Menu). 

 

The following screen displays: 

 

Step Action 

2  Select  (F2 - Account Add/Update). 
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The following screen displays: 

 

Step Action 

3  Select the drop-down selection icon  or enter the account number information in the Yr 

Fnd F Prgm Fnct Objct Fcty B Addt'l field and select  (Enter). 

The Fund, Function, and Object codes must be entered correctly, and may not contain all 

zeroes (0’s).  If 0’s are entered, "Account piece Not Allowed Value Of Zeros" displays. 
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The following screen displays: 

 

Step Action 

4  To update a Budget account:  Proceed to Step 5. 

To adjust the Original balance of a Budget account:  Proceed to Step 6. 

To delete a Budget account:  Proceed to Step 7. 

Select  (F17 – Print Screen) to obtain a screen print of the Budget Update screen.  The 

screen print file will be available in the print queue with the name ‘PSCNnnnn’. 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  1:53 PM  Page 22 of 65 

All Rights Reserved. 

Step Action 

5  To update a Budget account:  Make the appropriate entries in the following fields and select 

 (Enter) twice: 

 Tran Date (Transaction Date) – Enter the budget’s beginning date.   

The Tran Date (Transaction Date) determines when the transaction occurs.  Although 

PCGenesis defaults to the current date, it is recommended that the transaction date be 

changed so that the transaction date and the begin date are identical.  Some reports, 

including the DE0046 and DE0396, will not include the account information if the report is 

created with a date that is prior to the transaction date, even though the begin date falls 

within the report range. 

 Beg Date (Beginning Date) – Enter the date the account will become active. 

 End Date (Ending Date) – Enter the last date the account will remain active. 

 Fund Balance Acct (Fund Balance Account) – Enter 0799 (General Fund) or 0740 (School 

Food Services). 

 Enter Budget Adjust (Enter Budget Adjustment) – Enter the dollar amount. 

 Reason – Enter the reason for the modification, where applicable. 

 Title – Enter the description of the account, where applicable. 

Proceed to Step 8. 

6  To adjust a Budget account’s Original balance: 

On the Budget Account Record Update screen: 

a) To decrease the dollar amount:  Enter the negative (-) dollar amount in the Enter Budget 

Adjust (Enter Budget Adjustment) field.  The entry will be the negative (-) dollar amount of 

the Adj. Budget (Adjusted Budget) field.  Proceed to Step 8. 

To increase the dollar amount:  Enter the dollar amount in the Enter Budget Adjust (Enter 

Budget Adjustment) field.  Proceed to Step 8. 

b) Enter the dollar amount in the distribution month’s Amount field(s), where applicable.  

Where appropriate, manually distribute the Enter Budget Adjust field’s entry in any 

combination of months, or for a specific month.  The dollar amount(s) entered must however 

equal the dollar amount entered in the Enter Budget Adjust field. 

c) Original Balance adjustment:  Select  (F31) to adjust the original balance. 

The “Original Balance Adjusted, Enter to Post, F16 to Reenter” message displays.  Press  

(Enter) once and proceed to Step 9. 
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Step Action 

7  To delete a Budget account: 

On the Budget Account Update screen: 

a) Adjust the dollar amount of the budget account’s original balance:  Enter the negative (-) 

dollar amount in the Enter Budget Adjust (Enter Budget Adjustment) field. 

The entry will be the negative (-) dollar amount of the Orig. Estimt (Original Estimate) field. 

Select  (F31 - to Adjust Original Balance).  The “Original Balance Adjusted, Enter to 

Post, F16 to Reenter” message displays. 

b) Reduce the adjusted budget amount of the budget account:  Enter the negative (-) dollar 

amount in the Enter Budget Adjust (Enter Budget Adjustment) field, and select Enter (to 

Post). 

The entry will be the negative (-) dollar amount of the Adj. Budget (Adjusted Budget) field.  

The “Enter to Post, F16 to Reenter” message display. 

Verify .00 displays in the Adj. Budget (Adjusted Budget) field, and select  (Enter) 

twice.  PCGenesis redisplays the Budget Add/Update screen with the budget account number 

entered in the Yr Fnd F Prgm Fnct Objct Fcty B Addt'l field. 

c) Delete the budget account:  Verify .00 exists in the Adj. Budget (Adjusted Budget) and 

Orig. Budget (Original Budget) fields.  Select  (F12 - Delete), and  (F28 - to 

confirm delete). 

8  Select  (Enter) twice. 

Where appropriate, PCGenesis automatically calculates the account’s distribution amounts to 

the nearest dollar for all amounts exceeding $00.10, and for those amounts less than -$00.10.  

PCGenesis populates the field entries by transaction month.  Manually distribute amounts less 

than $00.11 and greater than -$00.11.   

If manually distributed, the amounts may be distributed in either any combination of months or 

for a specified month as long as the total for the transaction month’s distribution equals the entry 

in the “Enter Budget Adjust” field. 
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The following screen displays: 

 

Step Action 

9  Select  (F16 - Exit) to return to the Budget Account Master Menu. 
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The following screen displays: 

 

Step Action 

10  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu or 

select  (Master) to return to the Business Applications Master Menu. 
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Topic 4:  Printing the Budget Chart of Accounts 
Also run the Budget Chart of Accounts by selecting F9 (Financial Reporting and Month/Yr-End Close Menu) 

→ F3 (Budget & Revenue Account Master Reports Menu) →F3 (Budget Master:  Chart of Accounts).  This 

procedure and the corresponding screenshots are the same as those presented here. 

 

Step Action 

1  Select  (F1 - Budget Account Master Menu). 

 

The following screen displays: 
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Step Action 

2  Select  (F3 - Chart of Accounts). 

The following screen displays: 

 

Step Action 

3  Enter the date range (MM/DD/CCYY) in the Beginning Date and Ending Date fields. 

4  To include closed budget accounts:  Enter C (Closed accounts) in the To allow CLOSED 

accounts to be printed, enter a 'C' here field. 

5  Enter X in the Original Budget, Current Budget, and/or Current Balance field(s) to define the 

type of budget accounts where appropriate. 

6  Enter Y (Yes) or N (No) in the Printing each fund on a separate page field to define how the 

results will be printed. 
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Step Action 

7  
To print the Chart of Accounts only:  Select the radio button corresponding to None in the 

Create EXPORT File to load in Excel field, and proceed to Step 10. 

To print the Chart of Accounts, and to create a Microsoft Excel file:  Select the radio button 

corresponding to Export Current Fiscal Year in the Create EXPORT File to load in Excel 

field, and proceed to Step 8. 

To print the Chart of Accounts, and to create a Microsoft Excel file to be used for Budget 

Load:  Select the radio button corresponding to Export for New Fiscal Year BUDGET LOAD 

in the Create EXPORT File to load in Excel field, and proceed to Section 5B.1. Printing the 

Budget Chart of Accounts for Budget Load. 

 

For Step 7- Create EXPORT File to load in Excel entries, the following screen displays: 

 

Step Action 

8  Verify the C:\PCG folder exists, or create the folder where appropriate. 

9  Enter C:\PCG\BUDCHARTEXPT.csv in the Enter File Name and Path for Export File 

field, or select  (F10 to Browse for file) to locate the file. 

10  Select  (Enter) twice. 

“** Processing Request **” briefly displays. 
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The following screen displays: 

 

Step Action 

11  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

12  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu 

or select  (Master) to return to the Business Applications Master Menu. 

If creating an export file in Step 7 for the purpose of loading a new fiscal year budget, 

proceed to Topic 5:  Preparing the Import File for the Budget Upload. 
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4A. Budget Chart of Accounts – Example 
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Topic 5:  Preparing the Import File for the Budget Upload 

5A. Budget Account Export & Import Checklist 

  STEP ACTION 

 1  Create a folder entitled PCG, or verify the folder exists on the C:\ drive of the Personal 

Computer (PC). 

 2  Verify the Highest Allowable Transaction Date is greater than or is equal to the 

appropriate fiscal year.  Refer to Section N:  Special Functions, Topic 1:  

Displaying/Updating System Control Information for instructions. 

 3  Verify ALL account pieces, for example funds, programs, objects, facilities, and 

sources are valid in the Account Master Description File.    Refer to Section K:  

Account Master Description File Processing for instructions. 

 4  If performing a Budget Adjustment Import:  Define the account in the PCGenesis 

Budget Chart of Accounts. 

 5  Print the Budget Chart of Accounts for the new fiscal year.  This listing will be used for 

comparison purposes with the results of the budget import. 

 6  Create the PCGenesis Export file by printing the Budget Chart of Accounts and selecting 

the radio button corresponding to Export for New Fiscal Year BUDGET LOAD in the 

Create EXPORT File to load in Excel field. 

 7  Delete Fund 199 Balance Sheet accounts in the spreadsheet before beginning the 

PCGenesis Import. 

 8  Edit the Microsoft Excel spreadsheet before beginning the Import procedure.  

Correct errors resulting from invalid account numbers within PCGenesis, and on the 

Microsoft® Excel spreadsheet.  After correcting resulting errors, repeat the Import 

procedure.  Verify and finalize all budget entries. 

 9  Perform a PCGenesis Data backup. 

 10  Import the .csv file created from the Microsoft® Excel Import file into PCGenesis. 

 11  Print the Budget Chart of Accounts for the new fiscal year.  Compare these results to the 

listing created before performing the Import in Step 5. 
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5B. Budget Account Export  

5B.1. Printing the Budget Chart of Accounts – Export for New 

Fiscal Year 

Also run the Budget Chart of Accounts by selecting F9 (Financial Reporting and Month/Yr-End Close Menu) 

→ F3 (Budget & Revenue Account Master Reports Menu) →F3 (Budget Master:  Chart of Accounts).  This 

procedure and the corresponding screenshots are the same as those presented here. 

 

Step Action 

1  Select  (F1 - Budget Account Master Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F3 - Chart of Accounts). 
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The following screen displays: 

 

Step Action 

3  Enter the date range (MM/DD/CCYY) in the Beginning Date and Ending Date fields. 

4  To include closed budget accounts:  Enter C (Closed accounts) in the To allow CLOSED 

accounts to be printed, enter a 'C' here field. 

5  Enter X in the Original Budget, Current Budget, and/or Current Balance field(s) to define the 

type of budget accounts where appropriate. 

6  Enter Y (Yes) or N (No) in the Printing each fund on a separate page field to define how the 

results will be printed. 

7  To print the Chart of Accounts, and to create a Microsoft Excel file to be used for Budget 

Load:  Select the radio button corresponding to Export for New Fiscal Year BUDGET LOAD 

in the Create EXPORT File to load in Excel field. 
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When the radio button corresponding to Export for New Fiscal Year BUDGET LOAD is selected, the 

following screen displays: 

 

Step Action 

8  Select which budget accounts should be exported: 

When All is selected, all budget accounts are included in the budget export file.   

When Salary/Benefits Only is selected, only salary and benefit budget accounts are included in 

the export file.   

When Exclude Salary/Benefits is selected, all budget accounts are included in the export file 

except for the salary and benefit budget accounts. 

9  Select  (Enter) to continue. 
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The following screen displays: 

 

Step Action 

10  Verify the C:\PCG folder exists, or create the folder where appropriate. 

11  Enter C:\PCG\BUDCHARTLOAD.csv in the Enter File Name and Path for Export File 

field, or select  (F10 to Browse for file) to locate the file. 

12  Enter the fiscal year to be loaded during the Budget Load from External File process in the 

New Fiscal Year field. 

13  Enter the budget increase or decrease percentage in the % Budget Change field.  The 

percentage entered may be positive or negative.  Enter percentages as whole numbers.  For 

example 3.25% is entered as 3.25. 

14  Select  (Enter). 

“** Processing Request **” briefly displays. 

 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  1:53 PM  Page 37 of 65 

All Rights Reserved. 

The following screen displays: 

 

Step Action 

15  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

16  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu 

or select  (Master) to return to the Business Applications Master Menu. 
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5B.2. Creating the Microsoft® Excel Import File with the New 

Fiscal Year’s Budget Amounts 

The Creating the Microsoft® Excel Import File procedure formats the Export file created in Topic 5B.1:  

Printing the Budget Chart of Accounts for Budget Load, and creates the new fiscal year’s budget.  

Modify the export files by using these instructions. 

This document provides detailed instructions for the creation of the new fiscal year’s budget based on 

prior year amounts via Microsoft® Excel.  Instructions are also provided for saving the results in a 

Comma Separated Value (.csv) file suitable for the Budget Load from External File procedure. The 

following columns are required for the Comma Separated Value (.csv) import file: 

 Column A - Fiscal Year 

 Column B – Fund Code 

 Column C - Fisc Indicator (Always zero) 

 Column D - Program Code 

 Column E - Function Code (or Revenue Source) 

 Column F - Object Code 

 Column G – Facility Code 

 Column H - Building Code 

 Column I - Additional Code 

 Column J - Balance Sheet Account Code 

 Column K - Budget Amount 

 Column L – Description 

An additional column M with the heading CURRENT is included in the .csv file to aid in the analysis 

of the budget figures.  For your calculations, you may also wish to create additional formulas.  The 

CURRENT column (M) will be ignored during the import process. 

During the export process, the user specifies the percentage budget increase or decrease by entering a 

percentage into the % Budget Change field.  Valid percentages are either positive or negative values.  

During the export process, the PCGenesis system extracts the current budget figures based upon the 

Beginning date and Ending date entered on the input screen, and applies the % Budget Change 

percentage in order to create the New Budget Amount column (K).  The current budget amount upon 

which the calculation is based is extracted into the CURRENT column (M) for reference only. 

The export process may be run as many times as necessary, with as many different % Budget Change 

values as desired, until a satisfactory upload file is created.  The new budget amounts may also be 

manually adjusted individually where appropriate when editing the file in Microsoft® Excel as 

described below. 

Based on the version of software used, file extensions such as Excel Workbook (*.xlsx), Excel 97-2003 

Workbook (*.xls), Comma delimited (*.csv), and Excel 97-2003 Template (*.xlt), for example, may 

contain descriptions that differ from this document’s instructions.  Ensuring that the filename 

description selected, such as “Workbook”, “Spreadsheet”, and “.csv File”, corresponds to the file type 

indicated within the instructions, prevents additional processing errors. 
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***IMPORTANT*** 

Do not enter commas (,) in any of the Microsoft® Excel spreadsheet’s data fields as doing so creates 

incompatibilities with the .csv file’s format. 

 
The following instructions create a new fiscal year’s budget based on the current fiscal year’s budget 

amount. 

 

Step Action 

1  Open Microsoft® Excel. 

2  Navigate to C:\PCG. 

 

The following window displays: 

 

Step Action 

3  Click on the drop-down selection icon   in the Files of type field, and select All Files 

(*.*). 
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The following window displays: 

  

 

Step Action 

4  Click once on BUDCHARTLOAD.csv and click Open . 

If using a different filename during the file’s creation, select the appropriate file. 

Click once here, 

and click Open. 
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 The following screen displays: 

 

 

Step Action 

5  Delete the appropriate row(s) to exclude Fund 199 and all other accounts for which the user will 

not enter budgets. 

To delete a row, click once on a cell within the row containing unwanted accounts, or the 

appropriate account line.  From the Menu Bar, select Edit → Delete.  If the Delete Selection 

dialog box displays, click once on the radio button to the left of Entire row , and 

click OK  . 
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* * * Attention * * * 

Steps 6 – 16 are OPTIONAL and are included for your information to use as needed. 

Step Action 

6  To adjust the columns:  Select the appropriate columns.  With the columns selected, from 

the Menu Bar, select Format → Column → AutoFit Selection. 

7  OPTIONAL 

Save the spreadsheet as a Microsoft® Excel Workbook (*.xls) if extensive changes are 

required to the New Budget Amount values. 

8  To format the amounts within the inserted column:  Select the appropriate column by 

selecting once within the column.  From the Menu Bar, select Format → Cells.  Within the 

Format Cells dialog box, select the Number tab, and select Number from the Category column.  

Enter 2 in the Decimal places field and select  (OK). 

9  To format the width of the inserted column:  Select the appropriate column by selecting once 

within the column.  From the Menu Bar, select Format → Columns→ AutoFit Selection. 

10  Edit the Microsoft Excel spreadsheet before beginning the Import procedure.  Verify and 

finalize all budget entries. 

11  To change the fiscal year (YR) field:  Enter the two-digit year in Row A2 and select Enter.  

For example, enter 16 for FY16.  With Cell A2 selected, select Copy  .  A moving border will 

surround the cell’s contents.  Position the cursor within Row A3 of the column.  Select the 

remaining cells within the column by continuing to hold down the SHIFT key to the last cell 

within the column.  With all cells within the column selected, select Enter. 

You may also incorporate more creative sort options into the spreadsheet to verify budget 

amounts and to add more columns and totals.  Regardless of the purpose, all formulas must be 

converted into values before the file is imported into PCGenesis. 
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Step Action 

12  Where applicable refer to Appendix B:  Budget .csv File Formatting/Processing for the columns’ 

edit rules.  It is not necessary to format column widths and decimal positions.   

The following columns are required for the import: 

 Column A - Fiscal Year 

 Column B – Fund Code 

 Column C - Fisc Indicator (Always zero) 

 Column D - Program Code 

 Column E - Function Code (or Revenue Source) 

 Column F - Object Code 

 Column G – Facility Code 

 Column H - Building Code 

 Column I - Additional Code 

 Column J - Balance Sheet Account Code 

 Column K - Budget Amount 

 Column L – Description 

13  OPTIONAL 

Verify you have followed the instructions in Step 7 to save your file as a Workbook (*.xls) file.  

Saving the file in this format will facilitate future changes and makes it easier to recall the 

spreadsheet as needed. 

To save the file as a Microsoft Excel Workbook (*.xls) file for import into PCGenesis:  

From the Menu Bar, select File → Save As.  When the Save As dialog box displays, enter 

C:\PCG\BUDGETyy.XLS, where yy is the two-digit fiscal year, in the Filename field.  

Click on the drop-down selection icon    in the Save as type field and verify Microsoft 

Excel Workbook (*.xls) has been selected.  Click Save . 

14  REQUIRED 

Save the file as a .csv file to ensure the file is correctly formatted for import into PCGenesis. 

From the Menu Bar, select File → Save as.  When the Save As dialog box displays, enter 

C:\PCG\BUDGETyy.CSV in the Filename field where yy is the two-digit fiscal year.  This 

filename will be selected in 6B. Budget Load from External File.   

Select the drop-down selection icon   in the Save as type field and verify CSV (Comma 

delimited) (*.csv) has been selected and select  (Save).  When the Do you want to 

keep the workbook in this format? dialog box displays, select  (Yes). 

At this point, the “CURRENT” Budget information exists within the new fiscal year budget 

spreadsheet as a .csv file.  After making the modifications reflecting the new fiscal year’s dollar 

amounts, import the data into PCGenesis. 
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Step Action 

15  Close Microsoft® Excel. 

16  When the Do you want to save your changes? dialog box displays, select  (No). 

This prompt will always be displayed when exiting Microsoft® Excel after saving a file in 

the .csv format. 
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Topic 6:  Importing the Microsoft® Excel Budget.csv File into 

PCGenesis 

6A. Performing a PCGenesis Data Backup 

 
 

* * * ATTENTION * * * 

 

Performing a data backup before the beginning of the import of budget account 

information into PCGenesis is mandatory. 
 

Step Action 

1  Log out of PCGenesis. 

2  Make sure all other users log out of PCGenesis. 

3  From the PCGenesis server, perform a Disk-to-Disk backup:  

 Verify all users all logged out of PCGenesis.  

 Perform a PCGenesis full backup to CD or DVD.  

4  When the PCGenesis backup completes, label the backup media “PCG Data Backup 

BEFORE Budget Import - MMDDCCYY”. 

5  Maintain the Data backup media and the Backup Log until completing the Import, and 

verifying the resulting Chart of Accounts. 
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6B. Budget Load from External File 

 

Step Action 

1  Select  (F1 - Budget Account Master Menu). 

 

The following screen displays: 

 

Step Action 

2  Select  (F4 - Budget Load from External File). 
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The following screen displays: 

 

Step Action 

3  Select  (F10 - Browse for file), and locate the BUDGETyy.csv file saved in 5B.2. 

Creating the Microsoft® Excel Import File with the New Fiscal Year’s Budget Amounts. 

4  Enter ORIGINAL or ADJUST (Adjustment) in the Use data to set original budget or to enter 

budget adjustment field.   

To enter a budget adjustment, an original budget account must exist. 
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The following screen displays when entering “ORIGINAL” in Step 4: 

 

“Added Appropriation” automatically defaults in the Enter Reason Desc field when entering 

“ORIGINAL” in Step 4.   

The following screen displays if entering “ADJUST” in Step 4: 

 

“Change in Appropriation” automatically defaults in the Enter Reason Desc field when entering 

“ADJUST” in Step 4. 
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Step Action 

5  Enter, or verify the desired fiscal year has defaulted correctly, for example 16 for FY16, in the 

Budget Yr (Budget Year) field. 

6  Enter, or verify the fiscal year has defaulted correctly in the Tran Date (Transaction Date) field. 

The Tran Date (Transaction Date) determines when the transaction occurs.  PCGenesis defaults to 

the first day of the fiscal year.  It is recommended that if the begin date is changed, the transaction 

date should also be changed so that the transaction date and begin date are identical.  Some 

reports, including the DE0046 and DE0396, will not include the account information if the report 

is created with a date that is prior to the transaction date, even though the begin date falls within 

the report range. 

7  Enter the fiscal year’s date range (MM/DD/CCYY), for example 07 01 2015 and 06 30 2016 for 

FY16, in the Beg Date (Beginning Date) and End Date (Ending Date) fields. 

8  Verify the screen’s entries are correct, and select  (Enter). 

 

For import file errors, the following screen displays: 
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For successful file imports, the following screen displays: 

 

Step Action 

9  For import file errors:  Select Enter (to Continue).  Access the PCGenesis Uqueue Print 

Manager to print the report.  Within the Microsoft® Excel spreadsheet, correct the errors 

identified, and repeat this procedure beginning at Step 3. 

Appendix A: Budget File Scan Error Processing provides additional information on 

interpreting the errors.  View a sample of the report in appendix A1. Budget Upload Errors 

– Example. 

10  For successful file imports:  Verify the total dollar amount in the Total budget amount to be 

loaded is field is correct. 

If the dollar amount is correct:  Enter Y (Yes) in the Continue Y/N? field and select  

(Enter). 

If the dollar amount is incorrect:  Enter N (No) in the Continue Y/N? field and select  

(Enter).  The Budget Account Master Menu redisplays, and PCGenesis exits the import 

procedure.  Verify no duplicate accounts exist, and that the decimal point (.) is in the correct 

location. 

“Loading Budget Amounts” briefly displays, and PCGenesis updates the appropriate dollar 

amounts. 
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The following screen displays: 

 

Step Action 

11  When the Budget File Loaded Successfully screen displays, select Enter. 
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The following screen displays: 

 

Step Action 

12  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

13  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu 

or select  (Master) to return to the Business Applications Master Menu. 

14  To compare the Budget Chart of Account’s results from before the Import (Load) to the 

results after the Import (Load):  Repeat the procedures in Topic 4:  Printing the Budget Chart 

of Accounts.  Print the report for the PCGenesis import year. 

If the results are incorrect, contact the Technology Management Customer Support Center 

for assistance. 

15  Close Microsoft® Excel, where applicable. 
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6B.1. Budget Load Error Report (Corrections Required) – Example 

 

6B.2. Budget Load Error Report (Successful Upload) – Example 
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Topic 7:  Printing the Detail of Expenditures Report – 

Individual Account 

 

Step Action 

1  Select  (F1 - Budget Account Master Menu). 

 

The following screen displays: 
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Step Action 

2  Select  (F5 - Detail of Expenditures on Individual Account). 

 

The following screen displays: 

 

Step Action 

3  Enter the account information in the Yr Fnd F Prgm Fnct Objct Fcty B Addt'l field, and 

select  (Enter). 

“* * * Processing Request * * *” briefly displays and PCGenesis will automatically scan for 

account activity.   

If there is no activity, PCGenesis redisplays the screen above, and displays “No match on 

account selected”.  In this instance, select  (F16) to exit the screen, or enter another 

account number in the fields and select  (Enter). 
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The following screens display: 

 

Step Action 

4  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

5  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu 

or select  (Master) to return to the Business Applications Master Menu. 
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7A. Detail of Expenditures by Account – Example 

The final page of the report displays the account’s overall expenditure total and information regarding 

cancelled claims processing.  Please see the screenshot example below. 
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Topic 8:  Performing the Fiscal Year Budget Account Rollover 

 

Step Action 

1  Select  (F1 - Budget Account Master Menu). 

 

The following screen displays: 

 

Step Action 

2  Select  (F7 - Fiscal Year Account Rollover). 
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The following screen displays: 

 

Step Action 

3  Enter the date range (MM/DD/CCYY) in the Begin date and End date fields. 

4  Select Enter. 
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The following screen displays: 

 

Step Action 

5  Verify the screen’s entries are correct, and select Enter in response to the “Is above data 

correct?” message. 

“*** Processing Request ***” briefly displays. 
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The following screen displays: 

 

Step Action 

6  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu 

or select  (Master) to return to the Business Applications Master Menu. 
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Appendix A:  Budget File Scan Error Processing 
If the .csv file contains invalid data, the file upload will generate a Budget Load Error Report in the 

PCGenesis Uqueue Print Manager.  These errors will include the input file’s line number, the error type, 

and the field in which the error occurred.  If the program detects over 100 errors in a row, processing will 

halted.  Usually, repetitive errors are a sign of formatting issues or basic oversight in the data, such as 

leaving out a necessary column.  Compare the error(s) identified to the .csv file’s spreadsheet to determine 

the appropriate corrective measures.  An example of error messages and the spreadsheet generating the 

error messages follow: 

 

A.1. Budget Upload Errors – Example 
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A.2. Microsoft® Excel Spreadsheet – Example 

 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  1:53 PM  Page 64 of 65 

All Rights Reserved. 

A.3. .csv File for Budget Upload in Text Format – Example 
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Appendix B:  Budget .csv File Formatting/Processing 
Use the following information for technical reference for additional flexibility when creating the budget 

.csv file and to gain a better understanding of .csv file processing. 

Budget .csv File Format Requirements 

1  When creating the .csv file, the Budget Import processes all lines except completely blank lines, 

and lines with YR in Column A, or FND in Column B.  The check for YR and FND allow the 

program to skip the header line. 

2  Column A, (account Year) may contain up to 2 digits. 

3  Column B, (account Fund) may contain up to 3 digits. 

4  Column C, (account Fisc indicator) may contain 1 digit. 

5  Column D, (account Program) may contain up to 4 digits. 

6  Column E, (account Function) may contain up to 4 digits. 

7  Column F, (account Object) may contain up to 5 digits. 

8  Column G, (account Facility) may contain up to 4 digits. 

9  Column H, (account Building code) may contain 1 digit. 

10  Column I, (account Additional code) may contain up to 6 digits. 

 The account number represented by Columns A through I must be a valid account in the Budget 

(or Revenue) Chart of Accounts, if the processing mode is ADJUST. 

 The account number pieces represented by Columns A through I must be a valid in the Account 

Master Description file if the processing mode is ORIGINAL.  PCGenesis creates the account if 

it does not already exist. 

11  Column J, (Balance Account) may contain up to 4 digits. 

12  The amount entries within Column K must meet the following specifications: 

 12.1 May contain up to 9 significant digits before the decimal. 

 12.2 May contain 1 decimal point. 

 12.3 May contain up to 2 digits following the decimal. 

 12.4 May contain either a leading or trailing negative (-) sign. 

 12.5 May contain a leading $ sign. 

 12.6 May contain leading zeroes (0’s) or spaces before the significant digits. 

 12.7 May not contain embedded spaces or other characters not listed. 

 12.8 Total number of characters for each entry in the csv file in this column may not exceed 

15, including leading blanks or zeroes. 

13  Column L must contain an account description up to 30 characters. 

 Trailing blanks are not considered in the allowed length of the description 

 

 


